VISUALIZE DATA FROM GOOGLE ANALYTICS TO ANALYZE WEBSITE PERFORMANCE
INTRODUCTION

You are the owner of Office Equipment Centre, an office supply retail store, and you’re trying to get a 360-degree view of your business. A few years back you launched its website, making the products available to customers worldwide. You have been tracking your website’s traffic with Google Analytics to get customer location, number of sessions generated, type of visits, etc. But now you would also like to blend this data with your financial information and social media data your customers are posting on Facebook. This workshop will walk you through the steps of building an interactive dossier that delivers these business requirements.

GETTING STARTED

To complete this workshop, you will need to install MicroStrategy Desktop (make sure you use the latest version available) and have access to the MicroStrategy Web environment.

First, we will launch MicroStrategy Desktop:

1. From your list of programs, please run MicroStrategy Desktop.

2. Select New Dossier.

You will now enter the brand-new dossier authoring interface. Before we get started building a dossier, let’s briefly familiarize ourselves with the interface.
A. Toolbar: Provides controls to redo or undo an action, refresh the dossier, add dossier elements (including datasets, pages, chapters, visualizations, on-canvas filters, text, images, and links), change the format, and share your dossier. This is also where you can take advantage of brand-new responsive design functionality and preview your dossier in mobile and presentation mode.

B. Panel Control: The icons on the far left-hand side of the interface are used to show or hide different panels.

C. Contents Panel: With dossiers, you can organize your information into a chapter and page structure, allowing you to tell a story about your data. The Contents Panel is where you add chapters and pages to your dossier. Click on the editor icon in the Panel Control section to show or hide this panel.

D. Dataset Panel: The Dataset Panel shows the names and the elements of the datasets you have imported for your dossier. You can add additional datasets, delete datasets, and link two different datasets here. You can also add new metrics, attributes, links, etc. by right-clicking on the data elements in the panel. To show or hide this panel, click on the dataset icon in the Panel Control section.

E. Editor, Filter, and Formatting Panels

   a. Editor Panel: This is where you can drag and drop attributes and metrics to add data to your dossiers. Click on the editor icon in the Panel Control section to show or hide this panel.
b. **Filter Panel:** This is where you can add filters to your dossier at the chapter level, you can filter data based on the values of any attribute or metric to change your view to better understand your data. Simple checkboxes, sliders, calendars, and radio buttons make filters easy to use, and the impact of your selections is instantly visible. MicroStrategy also supports adding visualizations as a filter.

Click on the filter icon in the Panel Control section to show or hide this panel.

c. **Format Panel:** With dossiers, you can apply formatting options to enhance a user’s ability to view and read the information in your visualizations. Formatting options vary depending on the type of visualization you are formatting. Click on the format icon in the Panel Control section to show or hide this panel.

**F. Visualization Gallery:** Use the Visualization Gallery to quickly select the visualization you want to use to display your data, or import a custom visualization with just a few clicks. Click on the visualization icon in the Panel Control section to show or hide this panel.

---

**EXERCISE 1: DATA IMPORT AND WRANGLING**

In this exercise, you will create a dossier and use data wrangling to prepare your data.

**Overview**

In this exercise, you will import one dataset with data coming from Google Analytics and Facebook into MicroStrategy Desktop. You will then create a dossier based on this data.

After you have imported this dataset, you will use the data wrangling functionality to prepare the Google Analytics data to conform to the following:

1. You are only interested in pulling data from 1/1/2015 to 12/31/2017.
2. Because there are sessions and devices not identified properly, we will remove (no set) data values from our dataset.

Save your dossier as **Office Equipment Centre_[Your initials]** in your local system.

You are free to complete Exercise 1 on your own, or you can use the detailed steps that follow. If completing on your own, continue to Exercise 2 after saving your dossier.
Detailed Instructions

Import the Dataset

3. From the menu bar, click on the **Add Data** icon in the tool bar, and select **New Data** to open the **Connect to Your Data** interface.

For this exercise, you will import data from Google Analytics and Facebook. Let’s first add the Google Analytics data. Select the **Google Analytics** option.

In the next screen, enter the following credentials to connect to our Demo Account:

**email:** demo.microstrategy@gmail.com
**password:** MSTR2018
4. Click **Allow** to access the Google Analytics data.

   ![](image)

   By clicking Allow, you allow this app and Google to use your information in accordance with their respective terms of service and privacy policies. You can change this and other Account Permissions at any time.

5. From the Data Range drop-down select **Custom range** and enter a time window from 1/1/2015 to 12/31/2017.

   ![](image)

6. From the list of Folders displayed in the window, expand **Detailed Audience Device Data**, and select **Daily Operating System Data**. Scroll down in the folders list, and while pressing the Ctrl key, select **Overview of Visitors** to expand it, and select **New vs Returning Visits** and **Visits by Country**. Then select **Prepare Data**.

   ![](image)
7. From the top left section of the preview window, select **Add a new table**.

![Add a new table](image)

8. Select the **Facebook** option to add a new table into our dataset.

![Facebook option](image)

9. Using the credentials provided previously (in step 3), log into the Facebook account.

![Facebook login](image)

10. Type “Office Equipment Centre” in the search box and select **Search**.

11. Hover over the “Office Equipment Centre & The Copy Shop” option and select **Filter post data by date**.
12. From the drop-down menu select custom, and enter a time window from 1/1/2015 to 12/31/2017. Then click OK.

13. Select Add.

14. From the newly added tables to your Preview window, remove the Office Equ Page, Office Equ Comments, and Office Equ Likes tables by selecting the down arrow located at the top right corner of each table (see below image) and then selecting Delete.
Make sure you keep only the following tables.

15. Select the **Daily Operating System Data** table, then click the **Wrangle** button.

16. In the Data Wrangling window, from the first drop-down menu (located at the top) select the **Operating System** column, then from the second drop-down select the **Text Selector** function.

17. From the list of entries that appear in the bottom section of the window, hover over the **(not Set)** entry and select **Include**.
18. Select Delete Row included in Selectors and then click Apply.


20. In the Data Wrangling window, from the first drop-down menu, select the country column, then from the second drop-down, select the Text Selector function.

21. From the list of entries that appear in the bottom section of the window, hover over the (not Set) entry and select Include.

22. Select Delete Row included in Selectors and click Apply.

23. Back in the preview window, right-click on the Country attribute (in the Visits by Country table), select Define Geography, and select Country. Then click OK.
24. Click Finish.

25. Click the Save button on the toolbar.

26. Save your dossier as **Office Equipment Centre_[Your initials]** in your local system. This is now a shareable MicroStrategy file (.mstr extension).

MicroStrategy has two different views for displaying the attributes and metrics within a dataset. The **Flat View** displays all the attributes and metrics at one time. The **Table View** breaks the display down by each imported table. The view you choose is up to the user preference. For this lesson, we will choose to display the datasets in **Table View**.

27. Select the ellipsis icon adjacent to the **Datasets** panel and choose **Table View**.
EXERCISE 2: STRUCTURE YOUR STORY

Create a Table of Contents

Overview
Now that you have imported your data, you are ready to put together a compelling story. Dossier allow you to build a modern and interactive analytical book of your business. Each dossier consists of individual pages arranged in easy-to-navigate chapters. On each page, you can tell compelling stories about your data with powerful visualizations such as graphs and maps. To provide a guided experience for the users, dossiers include a Table of Contents that help you logically organize content into chapters and pages.

Create a Table of Contents with the following structure:
1. The first chapter should be called Web Traffic. It should have a single page labelled Visits and Sessions.
2. The second chapter should be called Social Media. It should have a single page labelled Facebook.

When finished, the Table of Contents will look like the following:

![Table of Contents Diagram]

You can complete Exercise 2 on your own, or use the detailed steps that follow. If completing on your own, continue to Exercise 3 after saving your dossier.
Detailed Instructions

28. Right-click on **Chapter 1** in the Table of Contents, and rename it to **Web Traffic**.

29. Similarly, right-click on **Page 1**, and rename it to **Visits and Sessions** – you want this page of your dossier to show the traffic analysis from your website.

30. Click on the **Add Chapter** icon on the toolbar to insert a new chapter into your dossier – notice that adding a new chapter also adds a page in that chapter.

31. Right-click on the newly added chapter, and rename it **Social Media**.

32. Right-click on **Page 1**, and rename it **Facebook**.

33. The table of contents should resemble the image below.
EXERCISE 3: VISUALIZE YOUR GOOGLE ANALYTICS DATA

Add a map, a line chart, a bar chart, and two KPI visualizations to your dossier.

Overview

In the Web Traffic chapter on the Visits and Sessions page, we want to display the geographical location of the web customers.

In the upper section of the dashboard, add two KPI visualizations displaying the number of new and returning visitors; below these two, insert a Map visualization based on the Country attribute and Sessions metric, and add a Red-Orange-Green threshold to highlight countries with a large number of visits.

Using the Date attribute, generate the Quarter time attribute, and use it in a line chart visualization. Then add the Sessions and Avgsessionduration metrics to the vertical axis of this chart.

Add two bar chart visualizations in the bottom section of the dashboard; the first one should display the Top 10 list of Sessions by Country. Use a filter appropriately.

The Visits and Sessions page will look like the following:
You can complete Exercise 3 on your own or use the detailed steps that follow. If completing on your own, continue to Exercise 4 after saving your dossier.

Detailed Instructions

34. Insert a Map visualization from the Visualization Gallery on the right.

35. From the Visits by Country table, drag the Country attribute into the Geo Attribute drop zone, then drag the Sessions metric to the Color By drop zone.
MicroStrategy, powered by ESRI, retrieves the latitude and longitude data for the **Country** attribute in our map visualization.

36. In the editor panel, select the **Format** tab.

37. From the first drop-down, select **Map Options**, then from the **Graphic type** menu select **Area**. Also, we would like to see the country names and the number of sessions from each of them; to accomplish this select **Text** and **Values** from the Data Labels section. Make sure you also check the **Show Legend** box. The map should look like the one below.
38. Now, let’s change the threshold color used in our map. Select the Editor tab, and then right-click in the Sessions metric and select Thresholds.

39. Select the Red-Orange-Green option from the Color drop-down. Then click OK.

Your map should now display a Red-Orange-Green list of colors depending on the number of sessions of each country.

40. Now let’s insert a second visualization by clicking on the insert visualization icon in the toolbar.
Let’s make sure that this visualization is placed to the right of the map. If the visualization is added below the map, you can drag it and move it around. To do this, you simply need to click on the **Visualization 2** header, hold the cursor and place it to the right of the map visualization. Your dashboard should look like the image below.

41. Select **Visualization 2**, and choose the **Line Chart** visualization from the gallery.
42. From the Datasets panel, in the Daily Operating System Data table, right-click the Date attribute, select Create Time Attributes, and check the Quarter option. Then click OK.

43. Drag the newly generated Date (Quarter) derived attribute.

Note: you may need to scroll all the way down in the Datasets panel to find it and drag to the Horizontal drop zone. Then, drag the Avgsessionduration and Sessions metrics (from the Daily Operating System Data table) to the Vertical drop zone.

44. Move the Metrics Names box from the Vertical to the Color by box, and then to the Break by box.

The line chart should match the below image.
45. In the Editor panel, right-click on the Avgsessionduration metric and select Right Axis. We want to have different scales, one for each metric.

Now the line chart should look as follows.
46. Add a third visualization by clicking the icon from the toolbar. Then drag it to the bottom section of the dashboard.

47. Click on Visualization 3 and select Bar Chart from the Visualization Gallery.

The dossier should look like this:

48. Drag the Country attribute to the Vertical drop zone and the Sessions metric to the Horizontal drop zone.

49. Right-click the Sessions metric and select Sort Descending.
50. From the top right corner of Visualization 3, click on the ellipsis, and select Edit Filter…

51. Click Add New Qualification.
52. From the **New Qualification** window, select **Sessions** from the Based on drop-down, **By Rank** and **Highest** from the Operator drop-down, and set **Value** to 10. The parameters should match the image below. Then click **OK**.

![New Qualification Window](image)

53. Click **Save**.

54. The visualization should now look like the image below.

![Visualization](image)
55. Move Visualization 2 to the right of Visualization 3.

56. Add a fourth visualization. Drag the new visualization to the top section of your dossier.

57. Click on Visualization 4, and select KPI from the visualization gallery.
58. Drag the **Sessions** metric to the **Metric** drop box. The dossier should look as follows:

![Sessions Metric Drop Box](image)

59. In **Visualization 4**, click on the ellipsis located at the top-right corner and select **Edit Filter…**

60. Click **Add New Qualification**.

61. Enter the following values in the **New Qualification** window:
   
   a. Set **Usertype** in the **Based on** parameter.
   
   b. Select **In List** from the **Choose elements by**.

   c. Check the **New Visitor** box.

Then click **OK**.
62. Click **Save**.

63. Make sure that **Visualization 4** is selected, then click the format icon \(\text{Format}\) in the Editor Panel.

64. From the first drop-down menu, select **Title and Container**.

65. Deselect the **Show titlebar** box.

66. From the first drop-down menu, select **KPI Settings**.

67. In the **KPI Name** section, select the **Lime** color.

68. In the **Display text** box, type “New Visitors.”

69. Add a fifth visualization. Drag the new visualization to the top section of your dossier (to the right of **Visualization 4**).
70. Click on **Visualization 5** and select **KPI** from the Visualization Gallery.

71. Drag the **Sessions** metric to the **Metric** drop box.

72. In **Visualization 5**, click on the ellipsis located at the top-right corner, and select **Edit Filter**…

73. Click **Add New Qualification**.

74. Enter the following values in the **New Qualification** window:
   
   a. Set **Usertype** in the **Based on** parameter.
   
   b. Select **In List** from the **Choose elements by**.
   
   c. Check the **Returning Visitor** box.

   Then click **OK**.

75. Click **Save**.
76. Make sure that **Visualization 5** is selected, then click the format icon in the Editor Panel.

77. From the first drop-down menu, select **Title and Container**.

78. Deselect the **Show titlebar** box.

79. From the first drop-down menu select **KPI Settings**.

80. In the **KPI Name** section, select the color **Gold**.

81. In the **Display text** box, type “Returning Visitors.”

82. Rename the visualizations by double clicking on the titles. Add the following titles to each of them:

   - Visualization 1 = **Sessions by Country**
   - Visualization 2 = **Sessions vs Avg Sessions Duration**
   - Visualization 3 = **Top 10 – Sessions by Country**

83. From the **Format** menu, select the **Harvest** Color Palette.
Your Visits and Sessions page should now look as follows:

New Visitors 4237  Returning Visitors 250

EXERCISE 4: VISUALIZE YOUR SOCIAL MEDIA DATA

Add a bar chart and grid visualizations to your dossier.

Overview
In the Social Media chapter on the Facebook page, we want to display the social media activity for the last six months alongside the comments from the customers.

In the upper section of the dashboard, add a bar chart visualization based on the likes, comments, and shares metrics and the Posts.created Time attribute.

Add one grid visualization in the bottom section of the dossier, use the Post.created Time, Posts.type, and Post.message attributes to display the customer message.

When finished, the Facebook page should look like the following:
You can complete Exercise 4 on your own, or use the detailed steps that follow. If completing on your own, continue to Exercise 5 after saving your dossier.

**Detailed Instructions**

Now let’s add content to the Facebook page in the Social Media chapter.

84. From the **Table of Contents** in the left panel, click on the Facebook page.
85. Click on **Visualization 1** and select the **Bar chart** from the Visualization Gallery.
86. Drag the `Posts.comments Summary Total Count`, `Posts.likes Summary Total Count`, and `Posts.shares Count` into the Vertical drop zone. Then drag the `Posts.created Time` attribute to the Horizontal drop zone. The visualization should look as follows.

![Visualization 1](image1)

87. Drag the Metric Names box from the Vertical into the Color by and to the Break By drop zones. Select Clustered from the Break By box.

![Visualization 1](image2)
88. We want to analyze the social media activity from the last six months, so let’s go ahead and add a filter. From the top right corner of the visualization, click on the ellipsis and select Edit Filter.

![Edit Filter](image)

89. Click Add New Qualification.

![Add New Qualification](image)

90. Set the parameters as shown in the image below.

   A. Set Posts.created Time in the Base on option.

   B. Set Qualification on in the Choose elements by menu.

   C. Set the Operator Greater than or equal to and the Value to be 7/1/2017.

   D. Then click OK.
91. Click **Save**.

The visualization should look as follows.

92. Add a second visualization by clicking the icon from the toolbar. Then drag it beneath Visualization 1.
93. Drag the **Posts.created Time**, **Posts.type**, and **Posts.message** attributes to the **Rows** drop zone.

94. To display the latest comments at the top of the grid, right-click the **Posts.created Time** attribute and select **Sort Descending**.

95. Rename the visualizations by double clicking on the titles. Add the following titles to each:

   Visualization 1 = **Activity – Last 6 months**
   Visualization 2 = **Comments**
Your Facebook page should like this.

![Facebook Activity Chart]

96. Click **Save**.

**EXERCISE 5: UPLOAD DOSSIER TO THE ENTERPRISE PLATFORM**

Upload the dossier built with MicroStrategy Desktop to the enterprise platform.

**Overview**

In this exercise, you will upload the dossier generated in MicroStrategy Desktop into the MicroStrategy Web environment provided and save it into the **My Reports** folder.

You can complete Exercise 5 on your own, or use the detailed steps that follow. If completing on your own, continue to Exercise 6 after saving your dossier.
Detailed Instructions

Upload the *Office Equipment Centre_[Your initials]* generated in your local system to the MicroStrategy Web environment.

97. Navigate to the URL provided in the text file within the supporting files folder and log in with the following credentials:
   Username: Instructor will provide
   Password: Instructor will provide

98. Click on the MicroStrategy Tutorial Project.

99. Click **Create** and choose **Add External Data**.

100. Locate the dossier *Office Equipment Centre_[Your initials]* generated in your local system and click **Choose**.

101. When you get the Upload Successful window, click **View Dossier**. Make sure the file is saved in the **My Reports** folder.
You should now be able to see the dossier uploaded into the MicroStrategy Web environment.

EXERCISE 6: MERGE THE OFFICE EQUIPMENT CENTRE DOSSIER WITH THE EXISTING DOSSIER FILE

In this exercise, you will merge the Office Equipment Centre Dossier with an existing dossier file that contains Sales Analysis Data.

Overview

In this exercise, you will insert the Office Equipment Centre Sales located in the Shared Report folder into the Office Equipment Centre_[Your initials] stored in My Reports folder.

You can complete Exercise 6 on your own, or use the detailed steps that follow. If completing on your own, continue to Exercise 7 after saving your dossier.
Detailed Instructions

102. In Web, open the Office Equipment Centre_[Your initials] dossier stored in the My Reports folder.

103. Go to the Insert menu and select Browse Objects.

104. Select Shared Reports from the drop-down menu and select Office Equipment Centre Sales. Then click Open.

Note how two chapters, each with one page, get added to the Dossier.
105. From the Table of Contents, select the **Summary** chapter and move it to the top of the list. Then select **Product Performance** and place it right below the Summary chapter. The Table of Contents should match the following image.

106. Now let's add a **Cover** image to our dossier. Click on the cover section and select any available image that you like from the list, or you can also paste an image URL.
107. After you make your selection click **Save**. Your Table of Contents now should look like the following.

![Table of Contents Image]

108. Click the **Save** icon to save the new dossier.

---

## EXERCISE 7: CERTIFY AND SHARE YOUR DOSSIER

### Overview

You want to share this dossier with your immediate reporting level. And you want your colleagues reviewing the content to be confident that it is accurate and has your seal of approval. You’ll need to certify your dossier to accomplish this. Certified dossiers help to maintain a single version of the truth, while providing flexibility for authoring content with multiple users.

Certify your dossier and add it to the [MicroStrategy](https://www.microstrategy.com) Library.

You can complete Exercise 7 on your own or use the detailed steps that follow. If completing on your own, continue to Exercise 8 after saving your dossier.

### Detailed Instructions

109. Save and close your dossier to exit the authoring window.

110. From the **My Reports** folder, right-click on your dossier and select **Properties**.
111. Check the box for **Certified** – Your dossier is now certified.

112. Re-open the dossier.

113. Click **Share** on the menu bar and click **Get a link to MicroStrategy Library**.

114. Click **Launch** to go to MicroStrategy Library, where you can test the consumer experience.
115. Using your credentials, log into MicroStrategy Library, and in the top right section, click **Add to Library** to add this dossier to your Library.

116. Click on the Library icon to go to your Library page.

Your Library should only contain one dossier so far:
EXERCISE 8: CONSUMING DOSSIERS FROM THE MICROSTRATEGY LIBRARY

Overview

Now that you have added your dossier to your Library, it's time to consume it. In addition to further analyzing your data, consuming your content from the Library allows you to optimally navigate through your dossier and collaborate in real-time with your peers.

In this section, we will cover the following:

1. Table of Contents
2. Collaboration
3. Sharing

Launch the Office Equipment Centre_[Your initials] that you created previously.

Tip: Note the ribbon on the left corner of the tile indicates that this is a certified dossier.

Detailed Instructions

Table of Contents

When consuming dossiers in MicroStrategy Library, the navigation-- no longer our traditional Sheet and Panel format -- is organized into a Table of Contents.
The Table of Contents provides a simple, intuitive navigation method for you to consume dossiers like a book of your business.

117. Open your dossier.

118. Open the Table of Contents to view the content of your dossier.

119. Navigate to the **Web Traffic** Chapter from your Table of Contents.

Collaboration
When consuming content through the MicroStrategy Library, you can now collaborate with other users in real time via the collaboration panel. With MicroStrategy, you can tag users at the page level and filter manipulations at the chapter level to directly pass context to other users.

Now that you are in the Web Traffic chapter, you noticed that the number of the sessions in your website has been decreasing over the last few quarters. You now want
to check with the marketing team to find out what will be their next campaign to boost sales and traffic to the website. For the sake of this exercise, assume that “MSTR user” is member of the marketing team.

120. Open the comment panel by clicking on this icon to begin a conversation with the marketing team.

121. Type a comment in the dialogue box, and then type @MSTR to tag the Marketing team in your comment. Then click Post.

Sharing

In addition to writing a note in the collaboration panel, you also want to ensure that the entire marketing team has access to the dossier in their Library, so each of them can consume it.

122. Click on the share icon and select Invite Users from the available options.
123. Type MSTR to find the user, check its name box, and click **Invite**

![Invitation screenshot](image)

At this point, the invited user will get a notification email that he/she has been invited to view the dossier. We will not be covering that workflow in this workshop. If you want to experience that workflow for yourself, you can invite yourself to the dossier.

**Note:** You can learn more advanced material by taking the MicroStrategy Class - 10.116: Introduction to Dossiers.

A consumer can also easily download a dossier as a MSTR file for offline use.

124. From the 📂 menu, select **Download MSTR file**.